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U7, TIOS XL —F 4 VIV AT LD8 & TEELET,

TV r— a7 7 —A7 71X Tibbo Basic SiETENNTEY . 7 =R RO
e P2 TOFAT8I0 2~ N7 7V r—va 77— LT ICE o THEREINT
WET,

FAT810 D7 7'V /lr— a7 7 —A U7 XY —Aa— KRR INTBY, By b7
v 7" C D D[Misc¥Firmwares¥SourceCode] 7 # /L Z —IZ A > TWE T,

H LHEREDEFCILENMETHIUE, TIDE TTF 7 r—ya v 77— 727 DY —
Aa—REHWTEETLZENTEET, LTV 7 NI =2T7~=27/L®D TIDE ®
HEeIlbALTEIW,

TIVr— a7y —AuxT D7 7 A/VEEEFAT810 127 v 7 ua— K9 5 A,
V7RG 2T ~w=aT VD [TIRARAIHVRTAO—F5—] DEBEBZTHALTEEN,

Jng5s3s29
FAT810 iy hU—7 A Ta~  FEELIZETHELET, Tz~ RiZ

%t LT FAT810 I35 & 2K L7,

* LUFTHHSHA TGS 2~ F/IZTROM0935 7 7 —A D = 7D~ NTH Y
ROM1069 T/L#4— F I FEA,
ROMO0935 /£ FAT800 D5 7' 2 f 2/t > I 2 L— AL TNET,
ROM1069 /g Etiik DT X pL—25 T,

FAT810 (21X, K& <BliFCarv ba—ravw s RETNAAL AV —R_—a< 2 KD 2 ZHh

Davy RBERH D 7,

ayvkA—J)LavoU R

avhp—navry NEAvE—VORRLTITF—0ar be—n F—y NS r s
7 X772 8 FAT810 O A SiHRe 2R3 2 7201 L £ 9

TCP 7 u ha v pMEHINTEY, 774/ FDOR—HKI1001TT,

Doy hra—)Lba< s RiX FAT800 AR %L E & i Td,

LCOay va—)La<wy NEZkOERIC > TnvET,
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STX = I ETX

T 7LD T STX (ASCIl =— K 02h) & ETX (ASCIl =— K 03h) 2MEHINET,
STX LV HATE ETX K %07 —F I3 THERAINET,

AR 74—V FORNEFIZOWTIHAY FA—LAT Y R AvE—VBXUREDHE
W2 DfiEE B AL TEE 0,

av ROFEITHRER L LT, FAT810 (& = — RhEREN T T—# ZIRLET,
Je& a2 — R & L Tld ACK(ASCII =— K 06h) 2> NAK (ASCIl ==— R 15h) O &5 58
WENFET, SO VT, 3 bA—ILaI VR, Ay E—VUBIUREEZIHAL
7230,

Bl . CLTFICFAT810 EARARPCEDRD EV A RLET, 22 b — LTI
DEITHHLTFETEBENZTHY £9, STX=0, ETX=9 ACK= & NAK=§

- TCPEFET
"R F>FAT810: OD01W ‘R—TFEE 1 DREFFEH A Vv E—UFFT
FAT810>7/RX k: & ‘OK

AR FDFAT810: OC® ‘LCDERTREF—DINVIT7EHL )T
FAT810>7RX k: & ‘OK

RR F>FAT810: OK9W ‘F—/\v FEXE EMIE (FELA T a v ERE)
FAT810>7RX F: § ‘NG

FIN RHF—R—aT VR

F 34 Z+H—,3—(Tibbo Device Server)~ > Ri%, FAT810 Dx v hU— VR ERL /
OB DOl Z1T 72V E 7,

TNA AP —N"—a< 2 RZUDP 7u ha Lz AL TEY, A— MI 65535 T,
FRFRER T N, A —_—a< RELUTFIORLET,

TNEFhoa~y R, 2l Eoh7Ferfb7zzLic (v ba—avwy RCEHTS
STXRETX D& 5 AL TEELIZ) BlaDUDP F—4% 75 L TELNET,

Bl . LLTFIZFAT810 EARARPCEDRD &V ERLET, ZILENDITHR] A D
UDP 5 — 4% 7 L& LET,

RRX F>FAT810: SPN1002 ‘R—rBBZ1002IZFEHE
FAT810>7RX k: A ‘OK
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aAvbkO—)LavT Uk, AyvtE—UBEURE
ZOVURAPNTEHKROELEFEHL TWET,

STX 02h

ETX 03h

ACK 06h

NAK 15h

m 1 /N IS A—4
n 1 /N IS A—4
bin NAF ) —

<Data...> T—20DOHEA

(A< FKFYREL)

avwy R X &% B

Y% Y% T7—LITF7N—= 3V ERT—EROWE
D Dmn REZFHAvE—DDFRT

C C LCDENYT7HEHEE

M Mn ) —F—DFEMEEHEL

K Kn F—\y FOEMIEEMIL

B Bn E— J &1

P Pmn BENSA—IDERE

@ @ TN RHERE

F F OGNV

| In F—a—FELEDLE

X Xmn F—a—FES

Y Yn<Data..> |[THFRA AV E—CDRTERE

S <Data...> [BHIAvt—Y - NEBGEARYEEDOH—RT—2ZELAvE—

T7—LIzF7N—23VERT—E2ROMEF

RAF = FINL R STX |V ETX
(3/81 k) 02H 56H 03H
TFINAR = KRRk “ROMXXXXV S”
(10814 k)
XXXX: 27—LozT7ES
V: N—3>
S: AT—H X (Fid 8w IM)
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B7 B6 B5 B4 B3 B2 B1 | BO
Clock/Data s¢&ft&fE | FH9 F—nNy K| U—4F— ECOR E—F F
TINA R
1:B%h = el N B =) 1:B%h 1"Z7RRAYRY 1Ny T 7 wIz “107
0: &% 3! 0:#3h 0CEHFERT [0:7on\vIT7

ZOa~xv  RTT7 77— T OfME, N—Yar, REIREZMALZENTEET,

REEFHAAVE—DDRT

RAF = T4 R STX D m |n [|ETX
(581 k) 02H |44H |bin |bin |03H
TINA R = KRR b ACK/NAK

(1314 1)

m: TXxAMAvtE—DEZE m=30H (EE)

n: RNR—IFS 31H<=

n<=3CH

EEPROMIZREESNTWVWDH A v =V LCDIZFERLET,
a< L REZ AT 26T 3 AT ACK 2K U TIREE A A v —V 2R Rm LET,
NS DOEE . NAK 2K L E£1,

FIAILFDAYvE—CAHAR

R—2 AE R—2 NE R—o NE
1 |Welcome 5 |Card error 9 |Verify fail
2 |[Enter PIN 6 |Press ENT 10 |Re-enter PIN
3 |PIN error 7 (Time out 11 |Thank you
4 |Swipe card 8 |Please try again 12 |Not working

LCD&ENYIPEHE

RA M = FINAX STX |C ETX
(8N4 k) 02H  |43H 03H
TINA R = KR b ACK/NAK

(11 k)

LCD ¢ RNy 77 ONEE 7 VT LET,
g REZITITHETF AL ZTACK iR L, RSO

AL NAK 2 L E 5,
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) —F—DEMEEHE

RAbF - FINA4R STX |M n ETX
(4/N4 k) 02H |4DH |bin |03H
TINAR = KRRk ACK/NAK

(1814 k)

n=3IHDEE, V—F—RBEDIGYET (TI4IL MREE)
n:30H0)<’:‘é'r ) —F—[FEMIGYET
IR RENBEBINDE. TNURIOKRECHIMOLT ) —F—FEDIHYFET,

o< REZFFIT A ET A AT ACK il L, FILLAOEEIEI NAK 2K L £7,

F—/8y FOEE/ERHE

RA R = FINL R STX |K n ETX
(434 1) 02H |4BH |Bin |03H
TINA R = KR+ ACK/NAK

(184 F)

n=3IHD EE, F—/Xy FIZEMIZHYET (T 74/ MREE)
n=30H 0)&% F—\y FIFEDZHYFET
FE EENBEFIND E.ENLURIOREIIAIDL LT X—/\y FIZEIZHEY ET,

Oy REZIFMTDHETNA RLACK IR L, FLANADEEITEI NAK 2K L F T,

— &
KA+ = FINL R STX |B n ETX
(484 F) 02H [42H |bin |03H
FINA R — KRR+ ACK/NAK
(184 k)

n: v rMEEICEDAIE—TED/NNE—
1E0IE. ZhEFN 0L IRE—THEZELT, FEFEDHBZEITHRHIELET,
FlZ £ n=F5H (11110101) THnIE. E—TFIXF TE——_. E. E] ELBY FT,

A~y REZIIIT D ET A ATACK KL, TSN OHEIEINAK iR L E T,

BENSA—SNDEER

KA R = FINA R STX |P m |n ETX
(5/8 F) 02H |50H |bin |bin |03H
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FINA R > KRRk ACK/NAK
(184 F)
INT A —HB DERBA

-FH9- ADE—F RRE—FK -FH- Clock/Data 4} Ep2EE
(m=31H) (m=32H) (m=33H) (m=34H) (m=35H)
n=30H, 7>/\v77E—F |n=30H, E#HFRTH* n=30H, #&%h (*)
n=31H, Ny 7 7E—FK ) n=31H, FRAYRY n=31H, H%}

@ EET 74 FDEE

BENRNT A =2 EEETHE, ZOWRETATE Y —(EEPROM)IZIRIFSNE T,
awy REZIIMNT RS, T RTHREZLEE L TACK 2K L £7,
TSN DEE . NAK 2 L £,

TN ZAFHE (VY k)

RAF > FINAR STX @ ETX
(8N4 k) 02H  |40H 03H
TINA R = KR b ACK/NAK

(1784 )

T RTCOREZ LHHARFORIEICR L ET,
a~wy RESTMHTESE. 7/\4?< IREZEET L TACK ZiK L ET,

ZNLS DA NAK 2R L £ 7,

RTRD BB
HRA R = FINA R STX |F ETX
(B3/81 k) 02H |46H  |03H
FINA R — KRR+ ACK/NAK
(181 k)

ROEE (BEPLF—AT) 217729 ETRREAWSEET,

Oy REZITMTHET SN ZAILACK #IK L, LN DEEII NAK 2K L F I,

F—a—FELEDLE

RAM = FINAX STX | m ETX
(4314 1) 02H 49H Bin 03H
TINA R = KRR k BEEMEDF—ICRESNTLSIE
(1814 1) /NAK
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0TH<=m<=14H FLVEDLERRDF—HEES

vy REZIHIT B & FAL AEES WX —(IBICRESNA TS a2 — F&K
ZALSOEAE NAK %32 LE T,

r—a—KFEE
RA R = FIN/M R STX X |m |n ETX
(581 k) 02H [58H |bin |bin |03H
FINA A = KRRk ACK/NAK
(184 F)

01HGEM=14H FEEMRDF—EERS
n EYHTHASCIH a—F

A~y REZIIIT D ET A ATACK KL, TSN OHEILINAK iR LET,

TERARA Y E—DDORTERHF

RRA K = T4 R STX|Y |n  |<DATA...> |[ETX
(5734 FRLLE) 02H [59H |bin |<DATA...> |03H
TINAR = KRRk ACK/NAK

(1314 1)

n=30H LCDIZTXFRrAVvtE—CFRT RTFELELY)
31H<=n<=3CH L CDIZTX*RA M AYytE—CZFREL, R—OFB B nIZR#E
TEARAYE—DEFE1 2R—CDBRICDEZ2NFEET

AR TAETIIRESNLAvE—COIBHEROT 74 L FRAIK. FHITRE
SN AyE—UTESHRAONET,

OV REZTTHET A ALTACK #Z KL TCLCDIZA vy b=V AR R L, FBE
INTZA V=Y NRKEEZEZ TS E NAK 2R L FE T,

BHAYE—Y - ABRGARYEEDON—FT—EZEAvE—D

BHIA vE—2iFa~ 2 RTEHARL . FAT810 SNJE A — R U —F — Bt - 727 —
ZHRARNPCIZELTLODAyE—UTT, ZOAyE—VIIRANPCIZXLTH
BRI EE S NET,
AR LTI Z Sk L COISE T2 46 8IEH Y 8 A,
AR+ Awyt—3
) —F—PNT—2 #5EAHIY STXOHS>H T —H >+<ETX>
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Bl : ROESGET—ENELNTEHE

FAT810 — 7RX kP C: [0S0123456789ABCDEFW
A— RFEDT—% (& 0123456789ABCDEF &LV 5 C &2 Y FT,

FiNAL AY—s3\— (Tibbo Device Server) a<w > FEBE

TN AP —N—a< NEIFAT8I0 DXy hU =71 /O OREEITIRVET,
FAT810 |35 a— RAZ IR L Ta~y ROFETHERZBEBMLUET,

O FaO—FR

NE
#MEA{E(Initialize)a < > K
REBEHAGe)aAT KR
REmMFGeh)aw UK
INT A—%A (Parameter)a <Y > K
Ia—avwo Kk
JH¥—Buzz)av v K
I P7 FLRZEE(Assign)a < > k

U
«
\i
u
|
™.

>IW(X[D|O|V|—|T7

BEI—F&
—F AR
OK
O<v 2 FI 35— (Command)
FI1TIEE (Rejected)
7 AZIE (Denied)
EITREX (Failed)

m|o|o({O|>|U

AL a<s

e - FAT810 O EA#MIHL L 3
avy FoER |

HEI—F: A

figEs

HIHE 2= > RiX FAT810 OF%E % LG HmRFORAEIZ R L £ 97,

HEBERAG) AT

BaE LW EEE EXIARLET
avy FOER - Sssvv...v

25 ©2009 JW-System Co., Itd.



ST~

ss: BEHH 22— RN, vw.vi T LR EE
HEI—F: AZFEllEC
fiEgR
REMH 2~ FIZEIR LZEHBIZH LWVMEE R E L E T,
ss IR EHEHa—F (& XXP'THIUTTI PT FLAOEREXEMRLET)
Fl: 1 P7 FLA% 192.168.100.40 |[ZF%ET AT D a~ 2 REkD £97,
SFAT: SIP192.168.100.40
FAT-: A

BRERFO@aATUF

BEE - BEOREMEZTAHLET
avry FoER Gss

ss: WEHHa—F
HEI—F: Avv..v £721X C

w...v: BITEDOR EE
fiReR
HERSGa~ v FIXBIR LHEE OBEOR EMEZ G LET,
SSIEFHEHEHaZ— R (& XIXP'THIUX T PT RLADEREEZEKRLET)
Bl BAED T PT FLAZBFT DIIIROD A~ ek £,
2>FAT: GIP
FAT->: A192.168.100.40

INS A—A (Parameter) A< > F

BEEE - TNA AP — N ZRTG A=A VA NT T a2k ET
ATV FOER : P<7F—%>
(F— 5 T — NG DN TIF INGA—REL RSO
IR E T HEAS S

INTG A =B a<w RI. T AP =N |ZINGA=BAL VAR NS0 %ED £7,
FAT810 TiX, Zd =~y RTHE/ SHF/VORM I/0 R—MNMIT 7 BEATE T,

fBil /0L A — FZ LOWIZT DIZIFRD A~ REXD £7,

>FAT: PS11

FAT>: A

Ta—X)avw>F

Hae FAT810 D AT — X AfEMA IR LET
avY FOER . X
BEI—F: Annn.nnn.nnn.nnn.nnn.nnn/ppppp/iiii/bb/oo..o/dd..d
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nnn.nnn.nnn.nnn.nnn.nnn- FAT810 ®MA C7 KL A
ppppp- FAT810 O AR — &5

bb- (F#9)

00...0- A —7F—%

dd...d- 734 24,
fiEER
To—a<wr NEFECRy hU—7 O FAT810 Z HEIRIC R R+ A0 H SN E7,
RANMIZOavwy 27— R¥y A RNE—RFRCTEEL. m—I/WZERINTWVDHE
TO FAT810 o JuZ %z E T, (B a—a~wr REMNESHEE TT)
FAT810 76 DIGEITIEL, 7 v — R¥x ¥ A hE— R TIE72 il # @ FAT810 LilfEd 57z
DIZHEEIMACT FLUREDERPEENTWET,

JH¥—@B) vk

e E—7EEEL LET
av Y FOER . B

BE&Ea—FK: A

iR

ZOawr REZE -7 FAT810 LI Ao v —7E %2 E 5 LE9,
ZHUXTI P7 RL AL FAT810 & OXFGIREEA I 55 ARICEHA TE £,

IP7ZRLRZEEMQN TR

e - MACT7 FLATHRELZFAT8I0 D1 PT7 KL AZAEHE L E7,

vy FOER Ammm.mmm.mmm.mmm.mmm.mmm/pp...p/ii.iii.iii.iii
mmm.mmm.mmm.mmm.mmm.mmm- #EDOHR L 25
FAT810 PMAC7T RL A

pp...p- (F#9)
jii.iii.iii.iii- FAT810 (ZEI W Y THH LWI PT KL A
&I —K: AEIXC

fiEgR

IP7 RLAEFa~y Ridxy U —7 ES{ERBIO FAT810 I L CTHLWI P T
RL 2B Y THHITHEMALET,

avr NiE7e— R¥y A ME— RTHEEINRITNITe 6T, BfEREZ 0 FAT810 (3=
<~ RHOMACT RLATHRESINET,

THa— KXy A FTIER—HIUIZORDBP S TNDEEEDOT RA AN a~r ReZfg LE
TR, —EHTIHIMACT R RA&ZED FAT810 721 A Z S s L E T,

Bl BEOXRI G L 72 % FAT810 DMA C T KL A 0. 150.30.213.55.74 T, HLWI P
7 RL A7 192, 168.100. 41 THivlL, kD a~> REED £,

>FAT: A0.150.30.213.55.74//192.168.100.41
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FAT: A

FLWI PT FLRE, 7o& 20 “SIP192.168.100. 417 O X 5 R E#HA =~ R&fE
FALBEA LRI, REEHDO NTPT FLARE] & LTRIEFEENET,

REBEH 2~ FEDEWNI MACT B LA THE Sz FAT810 23 FHE 872 LI R
IZEDTPT RLAZHEHLIZLD L/ TT,

HEIRE
ZITETAAL A= AR—DREFEA o~ FERERGa~ L F Tl I ZEDTE S
ETOFREHBIZOW TR L ET,
I H O EHE B 1L FAT810 O AR5 M A £ U (EEPROM)IZHEHN &5 DT FAT810 @
BERZ Y > THRENBITHA LA,
REHHIIRELS DT TRY FI—OBRELERRTEDO SO N—TI231F5H 2 N
TEET,

ry bI—YRE

X N — 7 BEITIT FAT810 DA 2 % v NU—VBECET 535 A — 2 " EaF
NTWET,
Yy bIO—UBRE—E

BEIEE (3—F) A&
#A—7+—4% (ON) FAT810 DA —F—4 ikl 1% ER L ET
T34 X4 (DN) FAT810 DT /A AL R T2 EFR L T
IP7EFLR (IP) FATSIO D I P7 RLAZEZRLET
R—+ES (PN) FAT810 OF —# R— FESEER L ET
F—r9xA4T7RKLR G) | T 74NV I —F U2 A DT RLAZERZLET
H TRy FTRY (NM) B—HNAPT Ry NOT FLAKIHEEFRLET

A—7F—%2 ON) xE
HEE - TN AY—NR—FDOF—F —ZEZEZLET
BREEAS)aYTY FERX : SONO0o0...0

00...0 [0~ 8 XFENDXZFF
BREMEGavYFExX: GON
FIHAME : GIGA-TMS
figEs
ZOREITTINA RBB/E & &~ T FAT810 D4 Mkl T 24k L £ 9,
TaA—avy NIHLT, 2OF—F =R LT A AANRISNLET,

g{!:

T 131 X4 ON) &&3E
B BE TNRA AP —=NR—HDOT N, A4 ZEHRLET
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BREBERAGS)aYY FER : SDNdd...d

dd...d (X0 ~ 8 XFMDXFF
BREmM/GavKFExX: GDN
PIEAME - FAT810
fiEgR
ZOREIIA—F—RBEL v T FAT810 DA FRHkp 2 L £,
Ta—avwy R LT, 2O —F—4 LT A ALBRINET,

I1P7 FLR(IP)E&E

HhEE FATBIO ® I P7 KL A% EHFRLET
BREBERAGS)aYY FER : SIPXXX.XXX.XXX.XXX

XXX XXX XXX XXX 1E Ry MMy & 10 EELEDO T P

7 KL A ({5 192.168.100.40)
BEMBG)ATYFERX: GIP
FIHEAME - PEEIEES WHELTEERESINEEA)
g
RIETH 1 PT RLAIX, FATBLO BORMNR-> TSRy NU—JIClHETHT RLA
TR TR 5 A,

=

R— &S PN) RE

e FAT810 7 — ¥ AR — " EH5EER L ET
BREBERAGS)avYY FER : SPNppppp

pPPPP (X 0 2> 5 65534 0 PH O Hfil
BREMEB/G)aAvYYFEX: GPN
PIEAE - 1001
figgs
FAT810 N\t & 1T ANLDH T —H R — FEHDKETT,

g{!{

St

F—r9zA4 1 P7FLRAGHEE

HeE - TIANV = T2 DI PT RLAZERLET
BREBERAGS)aYY FEX - SGIXXX. XXX XXX XXX
XXX XXX XXX XXX [ R M & 10 EFEDOT 7 41 b
=t xA1P7 KL A (#]192.168.100.1)
BREMBG)aAvYUFERX: GGl
PHAME - 0.0.0.1
g

BEHREIP7RFLRABRECTHESNTWVDRA MBE LT 7Ry FRTIERWEGEIZ,

FAT810 Wi H T 57 74NV K~ =24 DI PT7 RLATT,
VG DR A MNREI LY 7%y PN THLINEI NI, IPZRLULARE.EHEIPT
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FLREE. KOY TRy FIRIBEONAE CHIBI SN ET,

TRy bR (W) BE

Bk 0—HNAH T Xy FOIPT FLA#HAZER L ET

BREBERAGS)avYY FEX - SNMnn...n
nn..n &Ky MEE 10 EREOY TRy b~ RS
(] 255.255.255.0)

BREMEB/G)aAYUFERX: GNM

PIEAE - 0.0.0.0

fiEgR

VTR h~wAZZu—h T xy NOERERBELET,

FEATER T
PEoiak 1d FAT810 MDA A R & ED X 9 ICBfi 2Nt 3 50, £t 2% T ANLD
NERELET,
ERBRE—&

BEHEB (2—F) AR
BHITIPIAIEY DY (SF) | FAT810 2MEFED R A k)b DEEGE D 32T AL D D,
EDORA N THEZIT AN EERLET
EHJEIPZFLZR (D) FAT810 2NFED R A b & FEIT T 2B A 0. Bkt
IP7 FLAZERZLET

g{!:

BEHRITIPIA4ILEY YT SPERE
et - FAT810 N EDKRA MWD THT — X ka2 F ANLD
(T H Y TR FFEDRA N EOREET D
(T4 NI THR) EERLET,
BREBERAGS)aYY FER : SSFx
x:0 (E%h) F7-1L1 CA%h)
BREMEG)aAvYYFEX: GSF
EAE - 0 (E®)
fiEgR
BETIPIALRYITHRENO (S OL &, FATSI0 X ED Ry hT—J KA K
LD THZITANE T,
BRETIPIAILR)VITREN 1 (%) OL& X, FAT810 (1#E#KEk 1 P7 FLRARE
THRESNTZIPT RLALE—FTLHHRA MO ORI 2T ANET,

EHEEIPFZERFLAODNDERE
HHE FAT810 MUFEDRA k& It T D25 D, ki
IP7 RLRAZEFRLET,
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BREBERAGS)aYY FER : SDIXXX. XXX XXX. XXX

XXX XXX XXX XXX [ R M & 10 #EFLIE OB

I P7 R (f1192.168.100.41)
BREMB/G)aATUFERX:  GDI
PHAME - 1.0.0.2
g
BETIPIALIYIITEREN L (AR OLE, ZITRELLIPT RLADKA
R b 7T — 2 B A R T AVE T,

INGA—BREALA R MT O TY
ZZTIEFAT8IO DETDINGA—B LA VA MO I U OWTHER L £,
INTA—B | THREE I EEX LE T,
ZAUE EEPROM (ZIXfRAFE 9, HIEICEMEIC KM E N E 3, (FBEENIARETT)
AR NSH L 3 UITFAT810 (TR EDEEEZ EITS B £ 7,

NFGHA—=BRELA VRIS 3 V-8

NSGA=8 [ AR S9L3aY AR
I/OEVKREMEGO) A VRS (FEELL1/0R— FDIRIEEZARY £,
o3y

I/OEVEBEGCOA RSV |FBELET/OR— FORELZEIEL 7,

=

¥ AVARNT IV U EETSELHININSGA—R AT REERALET,
LU FATSIOWZIF N TR —Z A VA NI arDHIbL, A VA NT T ar DRMDFELET,
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1/OEVHREMBGOAI R FF923Y

et - FRE LA 1 /ODIRREZ Fi A HL D £,
INFA—=ZP)avT Y FEKX : PGx

X IZLHAT/ONEE
HEI—FK As,C,D £f=IEXR

s IFLAHT/ODKEE (0FIE1)

g
I/OEVHREMBA VA LSO aViE, x THRELEZNHI/ODKEZRLET,
x Dl 1/0R— b
0 PO
1 P20
2 P21
3 P22
4 P23

WENHPHT/ODIREE(s) 1%, EM1000 A —H %y hEV 22— LD 1 /0K — hDOBE
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Software Manuals

This part of the documentation describes all PC software related to FAT810 terminal.

FAT8xx Utility

Introduction

Thank you for purchasing FAT (FAT800/FAT810) terminal. FAT8xx Utility program has been
designed to work in conjunction with the FAT terminal equipped with keypad, reader and
display. The FAT8xx Utility program provides an easy way to utilize the functions and get all
the data inputted by user from the terminal.

Installing and Loading the Program

If your system has ever installed the old version program (including FAT800 Utility), please
remove it before installing.

Insert the FAT8xx Ultility Setup CD into the CD-ROM drive of your PC. The setup program
begins automatically. There is no need to choose your CD-ROM drive from your
on-screen settings, or to use the <RUN> prompt.

A html page will pop up. Click [Install FAT8xx Ultility program]. The setup wizard will now
guide you through the setup procedure. You will be prompted to accept a default path for
the FAT8xx Utility program, which is “'C:\Program Files\GIGA-TMS\FAT8xx Utility”.

You will now be asked to choose a name for your Start menu entry. You may type in your
own name if you wish, otherwise click <OK> to accept.

When the setup procedure is complete, remove the software CD-ROM disk from your
CD-ROM drive and accept the prompt to restart your PC.

From the [Start]/[Programs], select the [GIGA-TMS] (default folder), click [FAT8xx Utility].

Getting Started

Hardware setup

Plugged in power adaptor
B Connect FAT terminal to PC via communication cable WAS-1499. The
communication goes through the hub.

Program Setup

Launch FAT8xx Utility program.
For the first launch, a Broadcast window will pop up automatically.



Connection Settings (Local IP: 192.168.100.184) _XJ

Please select the checkbox of connected FAT800 below and then Refresh
click OK. —

MAC I IP ' Owner/Device hame GangelP...
[J0.234.76.202 192.168.100.221

[0.2.35.204.81 192.168.100.229 Test Connection
0.2.3.4.248 40

& Highlight
(" Checked
Al

Select All

Deselect All

: +
Note: If the selected FAT800's IP is not in the same segment of
PC's. pl: h the IP's t to ist with PC’s. Cancel

‘ Scan completed! ‘

In the Broadcast window, click the item of connected FAT’s IP (default value is 127.0.0.1)
Click [Change IP]. In the [Change IP-address] window, modify the selected FAT’s IP. The
IP subnet value should consist with PC’s.

Enter the new IP-address for the selected terminal

|P-address: e 10 ¥

oK I Cancel |

Tip: If the there are more than two terminals on the list and you are not sure which is the
certain one to be modified, turning off the terminal and click [Refresh], you can find out the
vanished one is just what you want. Then turning on the terminal and clicking [Refresh]
again.

192. 168. 100. 49

Network Address Subnet Address | Hosts Address

Note: An invalid IP will cause the PC and terminal can’t communicate to each other. If you
don’t well know about the network settings, it is better to set the network and subnet
address of terminal IP as same as the PC’s (each IP is composed of network address,
subnet address and hosts address). And the address that is going to be modified is the
hosts address. For example, if the PC’s IP is 192.168.100.49 (you can get the PC’s IP
from the caption of program windows), then the value of terminal IP should be
192.168.100.xxx, the xxx value is within 0~255 and must be unique in the LAN/network
system.

Click [OK], the new IP will apply on the selected FAT terminal.

In the Broadcast window, select the checkbox, and then click [OK].



Connection Settings (Local IP: 192.168.100.184)

Please select the checkbox of connected FAT800 below and then

x|

Refresh |

click OK.
MAC | P I Owner/Device hame Change IP... I
[J0.23.4.76.202 192.168.100.221 e —_
[10.2.3.5.204.81 192.168.100.229

(234248 40

192.168.100.215

Test Connection l

' Highlight
(" Checked
Al

4

Select checkbox
Select All

Deselect All

; g
Note: If the selected FAT800's IP is not in the same segment of
Cancel I

PC’s. pl h the IP's t to ist with PC's.

| Scan completed! l

® [f you have more than two FAT terminals connected to PC, re-select the checkboxes to
include into the list.

Configuring FAT terminal

Before loading the main window, program will try to establish the connection between FAT
terminal and PC. No matter the result of establishing connection is succeeded or failed, the
selected FAT IP will be listed on the tree view list of left side of main window.

B FAT8xx Utility (Local IP: 169.254.236.72) ¥2.0R6 (=3
File View Terminal Tools Help
op == Jad 3
=1 {n) Lasakberr 169.254.236.210: ROMO9354 v
169.254.236.210 169.254.236.211: ROMO745
5] 169.254.235.211 £3.254.236.211: B v
@ Remote Device
Available FAT terminals
Message | Terminal Properties ]
Send Binary Codes...
Send
Clear

Select an IP listed on the tree view, click button on the tool bar. A [FAT8xx Properties]
window will pop up. In this window, it allows you to configure all the parameters and functions
of FAT in an easy way.



# FA T8 Properties @

File Tools Help

vl

Keypad Status

External Keyboard Status 0 - Disabled
Reader Status 1-Enabled
Display Mode 1-Desktop
Character Displayed 0- Normal
Key Buffer 1 - Enabled
Keypad Layout <Table>
1/0 Status <Table>
Baud Rate 9600
Firmware Version 0745
Revision B

l[Configures the Keypad status.

FAT800 Properties Window

# FA T8¢ Properties @

File Tools Help

2|

Keypad Status

External Keyboard Status 0 - Disabled
Reader Status 1-Enabled
Character Displayed 0 - Normal
Key Buffer 1 - Enabled
Keypad Layout <Table>
170 Status <Table>
Baud Rate 9600
Firmware Version 0935
Revision A

[

IConfigures the Keypad status.

FAT810 Properties Window

Each parameter can be modified just by double-clicking the item value. For example, to
change the [Keypad Status], using the mouse to double-click the first row, second column cell,
then an editing window will pop up. Select the value you want, then click [OK] to modify the
[Keypad Status]. The functions are all located on the Tools menu.
" FA T8xx Properties
File S0 Help _

Show Pre-saved Text Message...
pA Save Displayed Text Message...

Show Pre-saved Image...

Keyp ,

| Save Displayed Image..

Exter™

FRea( Sound Intemal Buzzer.. L4
Displ Blink Screen »
—  SetBacklight

Char "
Key| GetMagnetic Stripe Data... ed

Keye Get RFID Tag Data...

1/0¢  Initialize Terminal
Bauc  Fimware Upgrade...

Firrnmara Versinn n74m



For FAT800 Tools menu

5 FAT8xx Properties
File BGLEY Help
Show Pre-saved Text Message...
pg Save Displayed Text Message... L

Keye  Sound Internal Buzzer...

Exter  Blink Screen le
Real (et Magnetic Stripe Data... B
Char  GetRFID Tag Data... 8l

K9l italize Terminal a

Keypau apuur e

For FAT810 Tools menu

Below is the list of parameters and functions that FAT provides.

Parameters
Name Description

Keypad Status Switch on/off the function of FAT keypad.

External Keypad Status Switch on/off the function of external keypad. Only
supported on FAT800A version terminal.

Reader Status Switch on/off the function of internal Reader. The type of
reader includes Magnetic Stripe reader, Barcode reader
and RFID reader.

Display Mode" Configures the way that how to display the message on
the screen. Wall-Mount or Desktop.

Character Displayed Determines whether characters typed by a user or
asterisk (*) character are displayed on the screen.

Key Buffer Determines whether directly send out typed characters
or kept in buffer until hitting Enter key.

Keyboard Layout Programs keys of the Keypad.

I/O Status Configure the I/Os of EM module.

Baud Rate Displays the internal baud rate that FAT800 uses.

Firmware Version Displays the version of a currently loaded firmware.

Revision Displays the revision of a currently loaded firmware.

Functions
Name Description
Show Pre-saved Text There are 12 text messages and 6 images that are
Message available to be stored in the memory of terminal. If you

have some messages that are often shown on the
display, it is a good way to pre-save these messages
(please refer to [Save Displayed Text Message] and
[Save Displayed Image] functions) and show them just




sending a simple command. By using this function will
be more speedy than sending the message (a string or
graph image).

Save Displayed Text Store the current displayed text message to the specified

Message [Page Number].

Show Pre-saved Image” Displays the specified page number of stored image.

Save Displayed Image’ Store the current displayed image to the specified [Page
Number].

Sound Internal Speaker Specifies the way of composing beeps to sound the
buzzer.

Blink Screen The terminal will blink the display every 1 ~ 2 second(s).

The terminal will stop blinking if there is any interruption
occurs. Like getting the data from PC, keypad pressed

by user etc.
Get Magnetic Stripe Data  |Get the track data from magnetic card reader.
Get RFID Tag Data Get the RFID Tag data from RFID reader.
Initialize Terminal Restore default settings.
Firmware Upgrade’ Upgrade firmware by specifying the firmware file.

Note: Marked * item is not support by FAT810 terminal.

Miscellaneous

Sending Message

If you want to send a message to specified FAT terminal, select the FAT’s IP in the tree view,
then enter the message in text box and click [Send] button.

B FAT8:xx Utility (Local IP: 169.254.236.72) Y2.0R6 (=[]
File View Terminal Tools Help
qp = Jal
=2 Local Device 169.254.236.210: ROMO9354 v
169.254.236.210 169.254.236.211: ROMO745
169.254236.211 Bv
169254236211 169554 536.211 ROMO745
@ Remote Device 169.254.236.211 B v
169.254.236.210: ROMOD9354 v

2. Click [Send] to

display the message.

Message | Terminal Properties I

Hello FATIN

inary Codes...

1. Input message here.

Clear
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Adding Remote Device

For the local terminals, it's easy to get the connected FAT’s IP by using Broadcast (from [Tools]
menu, click [Broadcasts]). But for the remote FAT (not in the same subnet as PC), it has to
enter by manually.

To do this, click 2° on the tool bar. Input the IP and select the location to [Remote Device,
(located behind the routes)], after entering the IP-address, then click [OK].

IP-address: |

Location: ILocaI Device (located on the same subnet) _'J

Local Device [located on the same subnet
Remote Device (located behind the routers|
0 ancel

Appendix
0 SUCCESS
-1 TIMEOUT
-2 INVALID COMMAND
-3 COMMAND EXECUTION FAILED
-4 ACCESS DENIED
-5 UKNOWN
-6 NETWORK NOT INSTALLED
-101 PORT NOT OPEN
-102 TIMEOUT
-103 INVALID DATA




-104 UNKNOWN

-105 INVALID PAGE MODE

-106 INVALID PAGE NUMBER

-107 GET NAK

-108 INVALID LENGTH OF BEEP STRING
-109 INVALID DATA OF BEEP STRING
-110 PORT ALREADY OPEN

-111 PORT ALREADY CLOSE

-112 INVALID BAUDRATE

-113 INVALID KEYPAD MODE

-114 INVALID DISPLAY

-115 INVALID MESSAGE LENGTH
-116 INVALID X POS

-117 INVALID Y POS

-118 INVALID X LEN

-119 INVALID Y LEN

-120 DEVICE NOT FOUND

-121 INVALID TRACK DATA

-122 CARD READ

-123 DEVICE TIMEOUT

-124 BUSY

-125 TCP NOT CONNECTED

-126 IP DUPLICATED

-127 DEVICE FULL

-128 DEVICE CONNECT FAILED

-129 IP NOT FOUND

-130 EM100 CONNECT FAILED

-131 CANNOT ESTABLISH TCPIP CONNECT

Tibbo IDE (INTEGRATED DEVELOPMENT

ENVIRONMENT)

Introduction

FAT810 opens the source code of application firmware that allows the user to modify by the
Tibbo IDE (TIDE) program to meet the needs. For example, implements the reserved two
serial ports to connect to other serial devices or do the off-line transaction with wanted

commercial logic. It is also able to create a html web page to allow the user to use web



browser to configure FAT810 settings without using FAT8xx Utility program. The language that
TIDE uses is Tibbo Basic. For the Tibbo Basic, the programming fundamentals are similar to
the QB (Quick Basic’) and VB (Visual Basic) languages, which allows the Basic programmer
to get started with developing the application firmware easily and quickly.

* QB (Quick Basic) and VB (Visual Basic) are registered trademarks of Microsoft Corporation
Inc.

Installing and Loading the Program

® Insert the FAT8xx Utility Setup CD into the CD-ROM drive of your PC. The setup program
begins automatically. There is no need to choose your CD-ROM drive from your
on-screen settings, or to use the <RUN> prompt.

® A html page will pop up. Click [Install Tibbo IDE program]. The setup wizard will now guide
you through the setup procedure.

® When the setup procedure is complete, remove the software CD-ROM disk from your
CD-ROM drive and accept the prompt to restart your PC.

® From the [Start]/[Programs]/[Tibbo] select the [Tibbo IDE], click [Tibbo IDE].

e b
@ Set Program Access and Defaults m

w wWindows Catalog

% ‘Windows Update

' Programs I Accessories

4
) Games »
4 Documents » @) GIGA-TMS 4
) startup »
B) Settings =
& Internet Explorer
Search » wh mMsn

[4) Outlock Express
¢ Remote Assistance
|® windows Media Player
43 windows Messenger
Lj Log OFF david. .. | windows Movie Maker
& Tibbo

g Device Explorer

B Tibbo IDE

Eg Tibbo IDE Documentation
&) Tibbo IDE on the Web
@ Uninstall

0\ Help and Support
=

Z~] Run..

|fagi Tibbo IDE

Programming with TIDE

The topics below attempt to give you a general understanding about programming of the
FAT810 application firmware. Before starting to use TIDE, make sure the FAT810 terminal is
connected well under the network.

Opening the Project

The source code files for application firmware are located in the path [Mics \ Firmwares \
SourceCode] of setup CD. Please copy the files to PC hard driver and set the read-only
attribute of all files to be unchecked.

Launching TIDE, to open the project file, from File, click Open Project.



ii! Edit View Project Debug Window Help

[ New Project £ "jt L"’: L"

| "=} Open Project

1 FATS10.tpr

Select the project file - FAT810.tpr, and then click OK to open it.
Below is the screen shot for opening the FAT810 project.

KD TIDE - Editing - FATB10.tpr, - [main.tbs]

By Fle Edt View Project Debug Window Help - 8%
= | > W 2 =
DB BERERIMEMANOMN (& D eaBdElBROGAHLTERIE
Project x include "io . tbh' ~
' Bromser| [ Fies include "res_info.tbh” 1
I Brawser ‘es‘ include "ron_set.tbh”
=B Fateio Erions include "sys_set.tbh
(=) Header Files sub InitPeripheral()
b5 _nvlib.tbh %nlt%CD( )d()
§ asc.tbh nitKeypas
i TnitSerial()
5 cmd_def tbh Tnithet (]
4§ cmd_queue.tbh InitSock{)
ioutbh InitIO()
res_info.tbh InitBesp()
rom_set.thh sye . buffallac]
sys_set.tbh ond =ub
2Revisions.tbh
) Basic Files function IsFirstLaunch() as boolean
b L tbs din =0 as string(5)
S beepths din sl as string(5)
§ cmd_queuetbs =0 = RES_Info("ROM" "Build") T
fo.ths sl - ROM GetSetting(ROM_EUILD_NO.ROM_BUILD_NO_SIZE,0)
keypad.th:
i if s0=sl then
ce.th IsFirstLaunch - false
main.ths else
niet.ths ROM_SaveSstting(ROM_BUILD_NO.ROM_BUILD_NO_SIZE.0.=0)
res_info.ths . I?FlrsLLaunDh = trus
end i
i rom_set.th end function
5 serial.ths
4§ sockitbs sub DebugTest()
L sys_set.tbs in = az string
5 timer.ths _ N - N
s = RES_Info('ROM", "Revision")
12 HTML Files = = RES_Infao("ROM", "HO")
(=) Resource Files
2] mfo.txt s = "ROM" + RES_Info("ROK"."NO') + RES_Info("ROM"."Revision')
end sub
sub on_sys_init()
" DebugTest()
if IsFirstlaunch()-true then
ROM_Initialize()
end if
]
£ J >
For Help, press F1 udp_broadeast:/f0.127.0.0.32,177 Edit Ln 15, Col 15 UM

‘4 start i tide bmp - Paint R TICE - Editing

Connecting to FAT810

It needs to specify the address of the FAT810 you will use for debugging and testing this
project. This should be a reachable address with a live FAT810. Your project will still be
created even if you do not specify this parameter, but you will not be able to upload or debug
until you specify this setting using the Project Settings dialog.

To do this, please follow below steps:

® From Project, click Setting

3 TIDE - Editing - FATB10.tpr - [main.tbs]
ﬁ File Edit View BZGER Debqgr Window Help

| Ej ;@ B [}IE&& Settings |ﬁ
M S Select/Manage Target ni
H@ Browser b File J

Add New File
= B FATS10(Em] |

[=-13) Header F Add Existing File it
ol " 63
ﬁ asct = Remove File
B cmd t1
» 1% puild F7 ni
B omd, &

® On Project Setting window, click Select



® Select the connected FAT810 item (with red color T letter icon), click Select

LI [ U Y0 O R LS e
% Project Setting:
T Patiom: MAC IP Yersion Comment
[ -_ ) | @ 012000628 1692642362 WIERMNL GIGA-TMS/F.. ‘
‘@ Em1000.-EM1000 Module "‘ fusomzz J ) 27 00,32, 169.254.236.2..  <EM1000-2.06.0...
o e qlY 01270032177 1692542362 <EM1000-206.0.. FATSI0 Change MAC
Project name: S PESata
r ebug Chanae IF
|FATS10 ‘ O version : L
Output binary filename: n(e:):-al 0 \
[FaTS10tpc Browse
1 | =
ar()
. : t("Wel
ransport:
| Taiko UDP Broadcast Transport v Go0L: 9
Target address: /\
[0127.0032177 ( | [ select
)
E ] senal ths This is a programmable Ti0S Device.
By socktbs
By sys_set.tbs
Es timer.ths

/
El

Coding the Project

This topic will not go details for the using way of TIDE code editor. For this part, the TIDE
on-line help can give you very detail information. Below give a example to demonstrate the
way of how to use TIDE to modify the FAT810 project to meet the needs.

Example

This example will make the code modification to show the way of changing the startup
displaying message while powering on the terminal. When starting the FAT810, the LCD wiill
display “Welcome” message and then give a one-long and two-short beep sound. Below steps
for the code modification will modify this to show the displaying message to be the terminal
IP-address.

® On Project browser (with tree view), click File tab

® Click main.tbs file

® Scroll the vertical bar of the code editor window to move cursor to on_sys_init sub routine.



£ TIDE - Editing - FATB10.tpr - [main.tbs]
By File Edit View Project Debug

heB e e N RS € & o
Project = s = RES_Info("ROM","NO")
El? BTOWSE(‘ B Files) B s = "ROM" + RES_Info("ROM","NO") + RES_Info{"ROM"
= Ej FATS10 (Em1000) I end.snb
25 E:ad: f?l;stbh < sub on_sys_ 11:@ h e
_myLib. ¢
2 .tbh
g ir::d def tbh if IsFirstlaunch()=true then
i ROM_Initialize(}
B cmd_queue.tbh shd Tf
B io.tbh , _ 9Code here to be modified
& res_info.tbh InJ_.t}?erlpheral( )]
B rom_set.tbh Friesys sty
B sys_set.tbh 'LCD Display
B zRevisions.tbh — st
[=1-15) Basic Files Displa;Text { “{lelcome" )
By _myLib.tbs " "o ) Y NO
& Beepitis BeepPlay (20000, "bbbbhb-b-*h ,PL_BEEP_HNOINT)
By cmd_gueue.tbs end sub
By io.tbs

By keypad.ths

N
=3

>

E el.(Ds

By res_info.tbs
By rom_set.tbs
By serial.tbs

By sock.tbs
By sys_set.tbs
Es timer.ths

® Remark the code “DisplayTest(“Welcome”) by entering the apostrophe character in the
beginning of the code
® Go to the next line, writing the new code “DisplayTest(net.ip)”, see:

'DisplayText ("Welcome")
DisplayText (net.ip)

® Pressing F5 (or from Debug, click Run) and wait

® You will see the project compiling. The output pane will display any errors (if you copied
the code as it is, there should be no errors).

® The status bar will show you the project building, uploading, and running.

® Once the status bar says RUNNING, you may see the LCD will display the IP-address of
FAT810 termianl

Building, Uploading and Running

Once you are done with writing the FAT810 project, it is time to build, upload and run it. These

three operations can be done by pressing F5. For more details, please refer to the section of
Making, Uploading and Running an Executable Binary of the TIDE on-line help.

Compiling a Final Binary

The binary executable file you compiled in the previous step is called a debug binary. This
type of binary is used while creating FAT810 project and debugging it.



When you decide FAT810 project is ready to be deployed in the real world, you should
compile a release binary. To do this, select Project > Settings and uncheck the Debug version
checkbox.

The next time you will press F5, a release binary will be created and uploaded to your target. It
will automatically start running and will not provide any debug information.

This release binary file also remains on your hard drive, inside your project folder. You may
take it and upload it to any number of FAT810s.

Device Explore

MAC IP Version Comment

@D 012000628 169254236211  <V3EENL> GIGA-TMS/FAT|
B
@D 01200061113 192168.100.223  <V3BE+NL> [+Profile]  QA/EM/PoE
@D 01200059166  192168.100.228  <V3BE+NL> [+Profile] QA/MF/POE Change MAC
@ 0234131204 192168100227  <V328(SpN [+Profi. / ‘
$5 023844221 127001 /
@D 0100025095 192168100245 V3 34(ShN /
@ 0202003202 192168100200  <V11.00> AUTHKE... Auth/Key
@0 01270032177 169254236210  <EMI000206.07>  GIGATMS/FAT|
S 0.127.00.32177  163.254236210  <EM1000-206.07>  FAT810
: ;
This is a programmable Ti0S Device.

This program shows all targets found on the current network segment. A target is a hardware
device capable of running TiOS. For example, the FAT810 terminal.

Cannot See the Connected Terminal

There can be several possible causes why you cannot see the terminal. Two of the most

common ones are:

1. The target is not connected to the same subnet as the computer. I.e, there is a router
between the computer and the terminal. To fix this: Connect the terminal to the same hub
as the computer.

2. There is alocal firewall installed on the computer. Local firewalls usually block broadcast
UDP datagrams, which are used to communicate with the target. To fix this: Configure the
firewall to allow Device Explore to send broadcast UDP datagrams.

Installing and Loading the Program

Device Explore program is installed together with TIDE program. If you want to use with
stand-alone without installing TIDE, please run the setup.exe file that located in the
[Programs \ Device Explore] folder of setup CD.


mk:@MSITStore:C:\Program%20Files\Tibbo\TIDE\Docs\Tide.chm::/pjt_compile_execmode.htm

To run the program, from [Start] / [Programs] / [Tibbo] / [Tibbo IDE], click Device Explore.

% Windows Update

Programs
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) Search » wd msn
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Below section will introduce how to upload the firmware by Device Explore. For more details
about this program, please refer to TIDE on-line help.

Uploading TiOS Firmware to FAT810

This section will guide you how to use Device Explore to upload TiOS firmware.
® Run Device Explore program

® Select connected FAT810 terminal itme on the list view

® Click Upload, a drop-down menu will pop up

i Device Explorer

MAC IP Wersion Comment Refresh
@ 012000828 169.254.236.211  <V3BB+NL> GIGA-TMS/FAT
@0 01200061113  192168.100.229  <V3.66+NL> [+Profile] QA/EM/PoE
@ 01200059166  192168.100.228  <V3E6+NL> [+Profile]  QAMF/POE Change MAC
) 0234131.204 192.168.100.227  <V3.28(S)>+N [+Profi... /
5 02384422 127.0.01 /
@ 0100025096 192.168.100.245  <V3.34(S)>+N / i
@i 0.202.0.03.202 192168100200 <V11.00> AL purgmer=mmmmm—m, Thml.\ghtheNetwoxk 1
® D00 T DI o s e o

— . : = Load Firmware Through the Serial Port

) |

® Select and click Load Firmware Through the Network

® Select the firmware file (the file extension name is .bin, for example,
tios-em1000-2_06_07.bin)

® Click Open to start uploading

Uploading Application Firmware to FAT810

This section will guide you how to use Device Explore to upload FAT810 application firmware.
Run Device Explore program

Select connected FAT810 terminal itme on the list view

Click Upload, a drop-down menu will pop up

Select and click Load Application Through the Network

Select the firmware file (the file extension name is .tpc, for example, FAT810.tcp )

Click Open to start uploading





